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Step by Step Guide to Creating an Audio Podcast - Audacity
April 8, 2009 by Sean
I wrote in an earlier post about publishing an audio podcast with my daughter Lucy. A couple of people have asked me for the details of how to create and publish an audio podcast, so I thought it worth compiling a step-by-step guide to creating an audio podcast.

What is a Podcast?
Before going through the individual steps, let’s just review what it is that we’re creating.

A podcast is an audio or video recording that you subscribe to and that you receive, automatically downloaded to your PC, whenever the publisher of the podcast publishes new episodes.

If you have an MP3 player, you can also set it up so that podcasts are automatically transferred to your MP3 player when you connect it to your PC.

To subscribe to a podcast, you need some software running on your PC or Mac that can automatically discover and download podcasts–known as “podcatcher” software. The most well-known example is iTunes, from Apple.

The most common scenario for enjoying podcasts looks something like this:

· Download and install iTunes

· Use iTunes to discover podcasts that you might be interested in

· Subscribe to those podcasts

· Get new episodes copied to your iPod whenever you plug it into your PC

So our ultimate goal is to publish an audio podcast that people can subscribe to and then listen to on their MP3 player.

Context
This post talks about how to create an audio podcast using Windows-based tools (i.e. on a PC). But the concepts are all pretty similar for Mac users. If you are a Mac user, you may want to go read this article. I’m also installing and testing everything on Windows Vista, but things will be very similar on Windows XP.

Step 1 – Buy a Microphone
To create an audio podcast, you really need very little in the way of hardware. Professional podcasters have more expensive equipment. But to start out, you can get by with a fairly low-end microphone.

I recommend going with a combination headphones/microphone headset, because this will ensure that the microphone stays close to your mouth while speaking.

Step 2 – Download & Install Audio Editing Software
Next, we need to get some software that will allow us to edit our audio recording. This isn’t strictly necessary. You could probably record your podcast in one sitting and then publish the resulting file. But you’ll likely want to do at least a little bit of editing, to make sure that your podcast sounds good, or to cut out unwanted segments.

I recommend a program called Audacity, which you can download for free. Audacity is a simply phenomenal software package and you just can’t beat free.

Use the link above to download Audacity, save the file (audacity-win-1.2.6.exe) to a directory of your choice, and then go run audacity-win-1.2.6.exe to start the installation. Follow all the the instructions to install Audacity.

After you install Audacity, you’ll need to install the “LAME MP3 encoder”. This is an additional piece of software that is required for saving your recording as MP3 files. Detailed instructions on downloading and installing the LAME MP3 encoder can be found on Wikipedia.

Step 3 – Hook Up Your Microphone
Next you’ll want to make a simple test recording–to ensure that your microphone is working properly and that you understand how to use Audacity.

First of all, plug in your microphone/headset. If you went with the one that I recommended above, you just need to find an open USB port. If you have a microphone that has a standard 3.5mm audio plug, you’ll need to find the microphone input plug on your PC or sound card. If you don’t have a mic input, don’t panic. You can just get a microphone USB adapter like this one, plug your microphone into the adapter and the adapter into your USB port.

Under Windows XP or Vista, your microphone should be fully functional after just plugging it in. But if you’re not able to get it working, after following the steps below, you’ll need to contact the manufacturer or check their web page.

Now that the microphone is plugged in, let’s make sure that it can hear us. The next step depends on whether you’re running Windows XP or Windows Vista.

Windows Vista
Bring up the Sound applet–from the Start Menu, open the Control Panel and then find Sound. Click on the Recording tab. You should now see your microphone device listed, looking something like this:


Make sure that the microphone device that you want to use has a green checkmark next to it. If it does not, right-click the desired device and select Set as Default Device. Left-click to select your microphone and then speak naturally into the microphone. You should see the green bars on the right side of the window move up and down as you speak (the louder you speak, the more bars you’ll see).

Once things are working properly, press the OK button to close the Sound window.

Windows XP
Under Windows XP, just proceed to the next step and test your microphone from within Audacity.

Step 4 – Make a Test Recording
Now start up Audacity so that you can make a test recording. At the top of the window, you’ll see some “buttons” for controlling your audio recording. Press the red button to start recording and start speaking naturally.
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As you speak into the microphone, you’ll see a visual indication of your recording–the waveform for your voice. (When you’re done recording, just click the yellow (square) button to stop the recording.
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If you speak at a natural volume, you’ll see something like the picture above. If you are speaking too quietly, or the microphone “gain” is set too low, you’ll see something like this:

[image: image3.jpg]X|audo Track v [ 1.0
ono, 441008z
oot | 0F

wite | soo || oo





If you are speaking too loudly, or the microphone “gain” is set too high, you’ll see something like this:
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In either case–signal too low or signal too high, you’ll want to either speak at a different volume, or change the properties of the microphone to change the default volume. In Windows Vista, you can change the microphone level by going back to the Sound applet that we opened earlier. On the Recording tab, left-click to select your microphone and then click the Properties button. On the Properties dialog, click the Levels tab. You’ll see something like the following:
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You can move the slider (the little blue knob) to the right (increase level) if your signal was too quiet/small. Or move it to the left if the signal was too loud/large.

Finally, going back to Audacity, you can play back the recording that you just made by pressing the green arrow button to play it back. You should hear yourself talking and see a little arrow moving through the signal, as it plays back. You’ll also green bars lighting up (labeled “L” and “R”) to show you the speaker levels during playback:
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Step 5 – Save Your Test Recording
Next, we’ll want to save this test recording as an .mp3 file. Under the File menu, select Export as MP3. If you can’t select this item, or get an error, you likely need to install the LAME MP3 Encoder, as described in Step 2.

In the Save MP3 File As dialog, locate a directory where you want to save your recordings/podcasts, give it a name (e.g. HelloWorld) and click Save. Next you’ll see a dialog labeled “Edit the ID3 tags for the MP3 file”. For now just click OK.

Exit Audacity.

Using Windows Explorer, locate the file that you just saved and double-click it. It should start playing, most likely in Windows Media Player, and you should hear what you just recorded.

Step 6 – Decide on Your Podcast Content and Length
This seems obvious, but it’s worth saying. Before you actually start recording, you should decide what you’re going to say. You probably don’t need to create a detailed script, but it may be helpful to jot down a short outline that lists the main topics that you want to speak about.

It’s also a good idea to decide on a target length for your podcast. This really depends on your goals and on who your listeners will be. But for starters, 10-15 mins is a nice goal for a first podcast. You’ll also probably want to pick a target length and stick to it, from episode to episode. If and when you have regular listeners, it will be a little irritating if the length of the podcasts changes from episode to episode.

You should also think about the purpose of your podcast. Is your intent to:

· Record information about your family for posterity?

· Tell a story?

· Educate people?

· Start a discussion?

If you know what your real purpose is for the podcast, you can then imagine who your audience is and what specific message you want to deliver to them. This will help keep your podcast focused.

Step 7 – One or Two Speakers?
You also need to decide if you will be alone on your podcast, speaking by yourself, or if you will have a guest or co-host. If you do have a second speaker, you’ll need to consider:

· The physical setup (e.g. two microphones)

· Agreeing ahead of time on the content and duration

· Agreeing ahead of time on the dynamics–who drives the conversation, who keeps you on track, etc.

Having two speakers means a bit more work in setting up your recording environment. You have several options here:

1. Two machines, two microphones, synchronize later

2. One microphone, one handheld recorder, synchronize later

3. Two machines, two microphones, use Skype to connect

4. Use external analog mixer, which microphones connect to

Most of the approaches are fairly straightforward, but beyond the scope of this post. The first two options are probably the easiest. You simply record each person on their own machine (or handheld recorder). Then, you export one of the recordings into .mp3 format and then import it into the other Audacity session. The only trick remaining is to line the two tracks up, so they are synchronized in time. One handy trick to help in doing this is to clap your hands or make a similar sharp sound at the start of your recording. The hand clap will show up clearly on both recordings and you can then easily line them up.

Step 8 – Record Your Podcast
It’s finally time to record your podcast. Press the big red button in Audacity and start talking. Speak clearly, continue talking, and don’t worry too much about mistakes. The easiest method is to record the show in its entirety, so that you do not need to do any “post production” editing later. But if you make mistakes, don’t worry–just take a brief pause and then try again–you can chop out your mistake in Audacity later.

When you are finished recording, press the stop button in Audacity. Then go to the File menu and select Save Project As. Save your project in the directory of your choice. What you are saving here is not the final audio output, but and Audacity project (.aup file).

Don’t forget to record an “outro” at the end of the recording. This is the point where you say things like: thanks for listening, see you next time, and list any relevant contact information.

Step 9 – Intro Music
If you like, now is the time to select some intro music for your podcast. Many podcasts start each episode with the same theme music. This intro typically last just 10 secs or so and fades out as the show starts.

The hardest part will be finding and selecting your intro music. You need to make sure to either get the express permission of the artist, or use music that is in the public domain, or covered under some open license like “creative commons”. If you want a good site to start with, take a look at ccmixter.

Once you select and download your theme music, just drag it into your Audacity project. Since this is the first track that will play when the podcasts starts, you may want it to appear at the top of the screen in Audacity. This isn’t required–it just makes it easier to make sense of the various tracks if the earliest appear at the top.

To move a track up, click on the phrase “Audio Track”, by the down arrow, and select “Move Track Up”.
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The next step is to cause your intro track to fade out to silence over time. You do this in Audacity using the Envelope tool. Click the envelope icon that appears in the upper left of the screen.
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Using the envelope tool is a little tricky at first. The basic idea is that you want to mark a series of points along the timeline, and the desired volume at each point. At the end of the track, you’ll use the mouse to select a zero-volume and then slide the mouse to the right to create a slow fadeout to that point. The end result should look something like this:

[image: image9.jpg]A e o i SO B AT R RS S TSR e e

Cdte L ol




Step 10 – Position/Edit Your Content
Now it’s time to edit the actual content of your podcast. If you were lucky enough to just record everything in one sitting, you just need to position the main audio track to start at the correct time. If not, you’ll have to do some deeper editing.

Your Audacity session should still have your main recorded content. You’ll want to slide it to the right so that it starts just as the intro music fades out. To start with, select the Time Shift Tool:
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Now you just need to grab your main audio track and slide it to the right. It will look something like this after you slide it (note that the dark grey no longer starts at the left edge of the screen).
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You’ll also want to chop out, or silence, any junk at the start of your recording–i.e. anything that you don’t want to be part of the final recording. To do this, first select the Selection Tool:
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Next, select the stuff you want to zero out, by clicking and dragging the mouse:
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Notice that what I selected is now a darker grey. After you selected the region that you want to make silent (delete), find the Silence Selection button on the toolbar:
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Click on this button–and the sound data that you selected in the step above will be silenced, showing as a flat line:
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More detailed editing is left as an exercise to the reader. One handy thing that you’ll want to learn is that to delete a chunk of of the recording, you first select it and then select Delete from the Edit menu.

Step 11 – Outro Music
No podcast is complete without “outro” music. Very often, this is a reprise of the original intro theme music. Or better yet, a variation on it that wraps up in a nice clean finish. As with the intro music, short is good–try to aim for 15-20 seconds at most.

With the outro music, you’ll want to “fade in” the music, bringing the volume up as the actual speaking part of the podcast ends. Once you do that, you can then slide the outro music around until the part the gets louder starts playing just after the last voice part ends. Here’s a visual example of doing this at the end of a podcast:
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The lower track is the music and the upper track is the voice part. Notice that the volume of the music gradually ramps up and then gets considerably louder just after the voice track ends.

Step 12- Export to MP3
Finally, you’ll want to export the entire contents of your Audacity project to a single MP3 file. This is the most common file format for publishing audio podcasts, so the obvious choice.

From the File menu, choose Export as MP3. You’ll see a dialog asking you for basic information about the track–artist name, album name and track name. Typically, you’ll want the album name to be the name of the podcast, the track name to be the name of the episode and the track number to be the episode number.

Step 13 – Publish Your MP3 File on the Web Somewhere
The next requirement is that you publish your audio file somewhere on the web where you can point to it with a URL. (E.g. http://www.seans.com/Podcasts/Lucyshow1/LucyShow-011-090405.mp3 ). Note that this is different from deciding where you’ll host the blog that you’ll need to publish the podcast. You need to host your actual .mp3 audio file somewhere. This means that you’ll typically have to sign up for a web hosting account somewhere.

One good option is a company like DreamHost, who provides unlimited storage for $5.95/mo. But if you just search google for “web hosting”, you’ll see plenty of options.

Note: you do not necessarily need to get your own domain name to host somewhere. Some hosting companies will provide a domain name at no extra charge (seans.com in the example above). But going without a domain name is fine, too. If you choose the latter, you still end up with a URL that points to your .mp3 file, but it might looking something like: http://www.hostingcompany.com/yourname/episode1.mp3

Once you arrange web hosting, you’ll need to upload your .mp3 file and jot down the full URL path to the file. If you’ve done things correctly, you should be able to enter that URL in your browser directly and the file will just start playing.

Step 14 – Create a Blog
Audio podcasts are made possible through the use something called RSS (Real Simple Syndication). The idea is that you publish “posts” and users automatically see your new updates, without having to go directly to your site. In the case of a regular blog, people make use of an “RSS Reader”, subscribe to your blog, and then receive new posts whenever you publish them.

Audio podcasts make use of blogs as follows. You create a regular blog, just as if you were going to publish written posts. Then you post a link to your .mp3 file, using the URL that we mentioned above. But instead of reading your post using an RSS Reader, people subscribe to your podcast using something like iTunes. Then whenever you publish a linke to a new episode (recording), they are automatically informed of the new audio file. And in the case of MP3 players like an iPod, the audio file is automatically downloaded to their player when they connect to their PC/Mac.

This will become more clear as we work through the steps. Let’s start by creating a new blog. There are several places to get a free blog, like WordPress and Blogger.

Let’s say that you want to create a blog with Blogger. Go to the Blogger site and follow the instructions for logging in and creating a new blog. (You’ll need your Google login information). Let’s say that you create something called mycoolpodcast.blogger.com

Step 15 – Create a New Blog Post
Now it’s time to create a new post that points to your podcast episode. Click on the “New Post” button. Give the post a title. Then enter a short description in the main text area. After the description, enter the title of your episode. At this point, you’ll have something that looks like this:
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Next, we’re going to select that second line and turn it into a hyperlink, pointing to the URL of your actual .mp3 file. Start by selecting the text with the mouse.
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Now click on the button that looks like a chain link on a globe.
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And then enter the full URL to where you published your .mp3 file (based on where your web hosting service is located). Here’s one example:
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Finally, save your blog post. You’ve just created an audio podcast. To test it, enter the name of your blog in your browser, e.g. http://mycoolpodcast.blogger.com . You’ll see the text that you entered as a description and a highlighted link to the episode. If you click on the link, your episode should start playing.

Step 16 – Subscribe To Your Podcast
Finally, let’s look at how to subscribe to your new audio podcast. I’ll use iTunes as an example. This step will demonstrate the step that anyone can take to subscribe to your podcast.

For starters, you need to be aware of what’s called your “feed”. A feed is just a representation of your blog in a format that podcatcher software (like iTunes) wants to see. The URL for your feed is based on the name of your blog at blogger.com. E.g. If your blog is http://mycoolpodcast.blogger.com , your feed URL will be: http://mycoolpodcast.blogger.com/rss.xml

Now we need to enter this URL into your podcatcher software to subscribe to the podcast. In iTunes, we do this by first left-clicking to select podcasts:
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Now select “Subscribe to Podcast” under the Advanced menu:
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Now enter the URL to your feed in the window that comes up:
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Click on OK and iTunes will add your podcast to the list of podcasts that it subscribes to.

Note that sometimes it can take a few minutes for a new blog post to show up in your feed–so don’t panic if iTunes can’t find the episode right away.

That’s all there is to it! You’ve just created an audio podcast, created your first episode, and shown how you can subscribe to it.

Postscript – Episode #2
So what do you need to do for the next episode? Clearly you don’t need to do all of the steps listed above. Here’s exactly what you do:

· Step 4 – Make a test recording

· It’s a good idea to do this before each episode, to make sure that your microphone is still set up properly

· Step 8 – Record your podcast

· Step 9 – Intro music

· You can open your old Audacity project and a new project side by side and copy/paste the intro music track from your first episode

· Step 10 – Position/edit your content

· Step 11 – Outro music

· Copy this from the earlier episode, as well

· Step 12 – Export to MP3

· Step 13 – Publish MP3 file on the web

· Step 15 – Create a new blog post

That sounds like a lot, but it’s really quite easy.

So there you have it. Once you go through the steps a couple times, you’ll see that creating your own audio podcast is really quite easy. Enjoy!

